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 Overview
Timbuktu Pro for Networks allows you to connect your PC to other Windows and Macintosh 
computers on your network. For example, you can share the most current versions of files 
with co-workers or show another user how to perform a task.
Timbuktu Pro's four services allow you to:

Send FlashNotes and files to other users

Exchange files between computers

Control another user's computer

Observe another user's desktop
Click an icon to jump to its procedure.
You can also receive FlashNotes and files from other computers that are running Timbuktu 
Pro.
Access to your computer is completely in your control. You assign the privileges available to 
users that access your PC and designate the network protocols that can be used for access.
The subtopics under Overview:
Connecting to other computers
Dialing a remote network
How secure can I be?
Using the address books
What connecting means



What is Exchange?
What is remote control?
What is Send?



 What connecting means
While Timbuktu Pro is running, you are able to connect to other computers, and, if you have 
granted the appropriate privileges, others may be able to connect to you. Depending on 
which of Timbuktu Pro's connection buttons you click, a connection may allow you to 
transfer files to or from another computer or to remotely observe or control the activity on 
that computer.
Connecting to other computers
Your PC can be connected to other Timbuktu Pro users over either a TCP/IP or NetWare 
network. Connection tabs that allow you to connect over TCP/IP or connect over NetWare 
appear only if the appropriate network protocol has already been installed in your PC. For 
example, if the TCP/IP tab does not appear in the main Timbuktu Pro window, your computer 
is not currently running its TCP/IP software.
How secure can I be?
If you want your computer to be available to other Timbuktu Pro users while Windows is 
running, you can minimize Timbuktu Pro to an icon and continue with other Windows work.
When you quit Timbuktu Pro, remote users cannot connect to your PC via Timbuktu Pro.



 How secure can I be?
Timbuktu Pro provides a comprehensive and flexible set of security options. No other users 
can connect to your PC for any purpose without your prior authorization.
Security

You have several levels of control over others' access to your PC.
Whenever you switch off user access -- either NetWare or TCP/IP -- none of the 

Timbuktu Pro users on that network can connect to your PC. You can still connect to other 
users, however.

Changing the user access privileges
When you configure Timbuktu Pro, you can define or change your computer name, 

define a master password for Timbuktu Pro, and set a reserve space and drop directory for 
receiving files from other users.

Setting your preferences
When you want another user to connect to your computer, you can create a 

registered user account that assigns privileges to him or her.
Adding, changing, and removing registered users

When you choose to allow Timbuktu Pro users to connect to your PC, you can define 
the types of passwords that your registered users can use for access. Registered users can 
define their own passwords for your PC, but you can restrict the range of passwords that can
be used.

Setting password requirements for registered users
When you want to grant attended access to a temporary guest, disconnect a current 

user, clear previous users from the user log, or view the activity log, you can use the 
Connections menu.

Admitting a temporary guest
Disconnecting a guest
Clearing previous users
Checking the activity log

When you want to leave your PC as accessible to your users as it is to you, you can 
allow unrestricted guest access.

Allowing unrestricted guest access
When you want to connect to another computer that is running Timbuktu Pro, you 

may be required to log on to that computer in a specific way.
Logging on

Whenever you exit the Timbuktu Pro application, no other users can connect to your 
PC. Of course, in that situation, you cannot use Timbuktu Pro either.

Exiting Timbuktu Pro



 Connecting to other computers
You can initiate an interactive session with another computer as either a registered user or 
as a guest user using the Send, Exchange, Control or Observe service. If you connect as a 
registered user, you are normally required to log on with your name and a password.
Sending FlashNotes and files
Exchanging files
Controlling another computer
Observing another computer

If you are operating as a remote node, you can dial in to a PPP server on a distant network. 
Once you're authenticated as a node on that network, you can use all Timbuktu Pro's 
functions with the workstations located on the distant network.
Dialing a remote network



 What is Send?
Using the Send command is similar to sending an electronic mail message to another 
computer. Timbuktu Pro saves the files you send in a drop directory on the remote computer.
Likewise, the remote user can send files only to your drop directory. Send does not allow the 
remote user to see the directories on your PC.
Send allows you to broadcast your FlashNote and enclosures to more than one computer at 
a time. This enables you to distribute your message to a number of Timbuktu Pro users 
simultaneously.
File transfer
Sending FlashNotes and files
If Enable Timbuktu Pro File Manager Extension was selected during the Timbuktu Pro 
Installation routine, you are able to send files from the File Manager as well as from 
Timbuktu Pro's main window.
Sending from the File Manager



 What is Exchange?
With the Exchange command, you can copy files in both directions between your PC and 
another computer. Exchange provides more flexibility than Send in the following ways:

You can see the names of the files and directories on both computers.
You can copy files to and from any location on either computer.
You can create a directory on either computer to receive the transferred files.
You can remove files from either computer.

Because of the complete access to the other computer allowed by the Exchange command, 
Timbuktu Pro users often grant this privilege as one or more subprivileges: Copy To (Write), 
Copy From (Read), and Remove.
File transfer
Exchanging files



 What is remote control?
When you control or observe a computer running Timbuktu Pro, the desktop activity of that 
computer is displayed in a Control window or in an Observe window. The window is updated 
as the other computer's desktop changes.
Remote control
When you control another computer, you can perform any of the tasks that you could 
perform locally, including opening applications, creating new files, and so on. This means 
that a user with the Control privilege can remotely create, modify or delete files without 
restriction, and can erase data from the another computer's disk. This privilege, therefore, 
should be granted with caution.
Controlling another computer
When you observe another computer, you can see the activity on its screen, but you cannot 
control any of its actions. This privilege is useful for diagnosing problems on another 
computer.
Observing another computer



 Dialing a remote network
When Timbuktu Pro detects that you have PPP dial-in client software installed on your PC, 
the Dial Remote Network command is enabled in the Connections menu. This allows you to 
log on to a computer network across a telephone line.
Refer to your network administrator and your PPP dial-in client software documentation to 
determine the appropriate entries in this dialog box. When your computer has been verified 
as a remote node on the network into which you have dialed, you can connect to another 
Timbuktu Pro user on that network just as you would if you were on-site.
Using Remote Connection Files



 Using the address books
The Personal connection tab displays your personal address book, and the Shared 
connection tab displays your shared address book.
The personal address book is a collection of Timbuktu Pro addresses that can include 
Internet addresses and Timbuktu user names. The user can add addresses from other tabs 
and edit entries in the personal address book.
The shared address book is a list of Timbuktu Pro addresses that is typically compiled by 
your network administrator. It can be read from your hard disk or from a network server. It 
can be edited only by the network administrator.
Connection tabs



 File transfer
Timbuktu Pro provides two file transfer services: Send and Exchange. You can use a service 
either by clicking its button in the main Timbuktu Pro window or by choosing its command 
from the Services menu. Notice that the Exchange service is enabled only if an address is 
selected in a connection tab.

Sending FlashNotes, files, and directories

Click Send to send a FlashNote, 
files, and directories to another 
user.

Click the icon to jump to the procedure.
The subtopics under Send:
Enclosing files in a FlashNote reply
Selecting files to send
Sending FlashNotes and files
Sending from the File Manager

Receiving FlashNotes, files, and directories
When you receive a FlashNote or file via Send, Timbuktu Pro displays a FlashNote window or 
a FlashNote icon, depending on the setting in your Preferences dialog box. You can discard 
the note, reply to the note, delete any or all of the enclosed files, or move the enclosures to 
another location on your hard drive.
The subtopics under Receive:
Deleting received files and directories
Moving received files and directories
Receiving FlashNotes and files
Setting the drop directory

Exchanging files and directories

Click Exchange to copy files and 
directories to and from a remote 
computer.

Click the icon to jump to the procedure.

When you receive a file via Exchange, the transfer takes place in the background. 
FlashNotes cannot be sent from the Exchange service.
The subtopic under Exchange:
Exchanging files



 Sending FlashNotes and files
To send notes and files from within Timbuktu Pro:

1. Select the remote address and click the Send button. If Timbuktu Pro asks you to log on 
with a name and password, enter them and click OK. The FlashNote window is displayed.
Selecting a remote address
Logging on

2. If you want to include files with your message, click the Files button and make your 
selection in the Select Files to Send window.
Selecting files to send

3. If you wish, type a message in the FlashNote field. If you do not type a note, Timbuktu 
Pro sends a default note indicating the sender's computer name, date, and time.

4. If you are ready to send the note (and any files you may have attached), skip to step 9. If
you want to send the note and files to additional users, click the To button to display the 
Select Timbuktu Addresses dialog box.

5. Using the same technique you used in step 1, select the next remote address from the 
appropriate connection tab.

6. Click the Add button.
7. Repeat steps 5 and 6 to select any remaining recipients.
8. Click the OK button to return to the FlashNote window.
9. Click the Send button to send the note and files.
If the Send service turns down your file transfer request, it means one of four things:

The Send privilege is not granted to your user account on the remote computer.
Timbuktu Pro is not running on the computer you are trying to contact.
If you are using IP, the IP address of the remote computer may be incorrect.
Another user is connected to that computer.

If you are sending files to a Macintosh, keep in mind that Timbuktu Pro handles messages 
slightly differently on the Macintosh.
Sending files to a Macintosh computer

While Timbuktu Pro is sending files, you can

Click the Stop button. Timbuktu Pro immediately halts the file transfer. The file being 
sent at the time you cancel is not transferred, but the note is sent. All files transferred before
you clicked Stop remain in the drop directory of the remote computer.

Click outside the FlashNote window to return to other tasks on your PC.

You can also send files directly from the desktop using the FlashNote window or using the 
File Manager.
Enclosing files in a FlashNote reply
Sending from the File Manager

Finally, you can send files while controlling or observing another computer.
Transferring files during a remote control session



 Sending files to a Macintosh computer
You can send files to Macintosh users who have Timbuktu Pro for Macintosh installed. If the 
Macintosh is running version 1.x of Timbuktu Pro, the FlashNotes are not displayed 
automatically, as in Windows, but they can be opened by a text editor or word processing 
application.
When a PC file is sent to a Macintosh, Timbuktu Pro attempts to assign a Macintosh Type and
Creator that are appropriate for that file. For more information, see Appendix B, "File 
Extension Mapping Tables," in the Timbuktu Pro for Networks User's Guide.
Translate Between Macintosh and PC Text File Formats



 Enclosing files in a FlashNote reply
Suppose that you have just received a FlashNote requesting a file. You need to send a file 
back to the other user.

To enclose a file in your reply:

1. Click the Reply button.
2. Click the Files button to select the desired files or directories.
3. Browse as necessary to locate the files you want to send.

To select a different drive, click the down arrow in the 
 (drive) field and choose the desired drive from the drop-down list.

Select the desired directory from either panel. To display the contents of the 
directory, double-click it.
4. Select the desired files or directories or both from either panel.

To select a group of consecutive file names, click the first name in the list, then hold 
down the Shift key and click the last name in the list.

To select nonconsecutive files, hold down the Ctrl key and click each file name.
5. Drag the selected items to the Selected Files list or click the Add to List button.
6. If you need to remove any of the files you've added to the Selected Files list, select them 

and click the Remove from List button.
7. When the list of files and directories is complete, click OK to return to the Reply To 

window. The files you selected appear in a list box above the body of the note.
8. Type a reply note, if desired.
9. Click Send.



 Sending from the File Manager
Note: If Enable Timbuktu Pro File Manager Extension was not selected during the Timbuktu 
Pro Installation routine, the Timbuktu Pro menu is not available in the File Manager.

To send notes and files from the File Manager:

1. Open the File Manager. Notice that a Timbuktu Pro menu has been added to the menu 
bar.

2. In the File Manager, select the files you want to send.
3. If the FlashNote window (or icon) or the Timbuktu Pro window (or icon) is visible, you can 

drag the files onto any of them. You can also choose Send file from the Timbuktu Pro 
menu. The Timbuktu Pro FlashNote window appears with the selected files attached.

If you dragged the files to a FlashNote window, the destination may already be 
selected.

If you dragged the files to the Timbuktu Pro icon, you'll need to select the desired 
address(es).
4. If desired, type a message in the FlashNote field.
5. If you are ready to send the note, skip to step 10. If you need to specify the address(es), 

click the To button to add the address(es) in the Select Timbuktu Addresses dialog box.
6. Highlight a remote address.

Selecting a remote address
7. Click the Add button to add the recipient you just selected to the list at the bottom of the

window. You may be prompted for a user name and a password.
Logging on

8. If you are ready to send the note (and any files you may have attached), skip to step 9. If
you want to send the note and files to additional users, repeat steps 6 and 7 to select 
any remaining recipients.

9. Click the OK button to return to the FlashNote window.
10. Click Send.
If the Send service turns down your file transfer request, it means one of four things:

The Send privilege is not granted to your user account on the remote computer.
Timbuktu Pro is not running on the computer you are trying to contact.
If you are using IP, the IP address of the remote computer may be incorrect.
Another user is connected to that computer.



 Selecting files to send
To select a file from within the Select Files to Send window:

1. In the  (drive) field, select the drive you wish to use from the drop-down list.
2. In either browse list, highlight the directory that contains the files or directories you 
want to send. If an item you wish to send is inside a directory, double-click the directory to 
display the nested file or directory.
3. Click the Add to List button.

Alternatively, you can drag the item from either browse list to the Selected Files list.
Note: You can select multiple files or directories in the right-hand browse list or in the 

Selected Files list.
To select nonconsecutive items, hold down the Ctrl key and click the individual files 

and directories.
To select consecutive items, hold down the Shift key and click the first and last items 

in a series of files and directories.
4. Repeat steps 2 and 3 to include additional items in the Selected Files list.
5. If you need to remove any of the files you've added to the list, select them in the 

Selected Files list and click the Remove from List button.
6. When all the desired files and directories have been selected, click OK to return to the 

FlashNote window.



 Receiving FlashNotes and files
Other Timbuktu Pro users can copy files to your computer using either the Send or the 
Exchange command. You can receive files from Macintosh computers as well as other PCs. If 
necessary, file transfers can be stopped at any time. You can also restrict the amount of 
access other users have to your PC.

Receiving files via Send
Receiving files via Exchange
Receiving files from a Macintosh
Halting a file transfer
Restricting access to your PC
To display one of these subjects, you can either scroll through this section or you can jump 
directly to specific information by clicking on the name of a subject.

If you are receiving FlashNotes and files via the Send function, Timbuktu Pro displays a 
FlashNote window or FlashNote icon, depending on the setting in your preferences box. The 
FlashNote icon looks like this:

If you get an icon, double-click it to display the FlashNote window.
If you have received a FlashNote with no files attached, you have two options:

If you want to discard the note, click the Discard button.
If you want to reply to the note

1. Click Reply.
2. Type your response in the FlashNote window.
3. Click Send. The message is sent immediately.
If you have received a FlashNote with an enclosure attached, you have four more options:

Double-click the enclosure to open it directly from the FlashNote.
Save the enclosures in your drop directory.
Move the enclosures to any directory you choose.
Delete the enclosures.

To save enclosures in your drop directory:

1. Close the FlashNote window. Timbuktu Pro asks how you want to handle the enclosures.
2. Click Leave Enclosures. If you have not specified a drop directory, Timbuktu Pro creates 

one, called FILES, and saves it in the root directory. It then saves the enclosures in a 
Date/Time directory within a Sender directory. The Date/Time directory draws its name 
from the date and time it was received on your PC. The Sender directory draws its name 
from the sending computer.

Moving received files and directories
Deleting received files and directories

You can set the name and location of the drop directory on your PC. The Preferences dialog 
box allows you to specify the way in which the Send service receives FlashNotes and 
enclosures.
Setting the drop directory
Setting your preferences



Note: If you receive a file while Timbuktu Pro is minimized, the regular Timbuktu Pro icon is 
replaced with an icon that alternates between the regular Timbuktu Pro icon and an icon that
indicates which service was used to connect to your PC.

 indicates that someone connected to your PC via Send.

If you are receiving files via the Exchange function, the User Connections counter in the 
Status bar of Timbuktu Pro's main window increases by one. The exchange takes place in the
background, so your work is not interrupted by dialog boxes or alerts.
Note: If you receive a file while Timbuktu Pro is minimized, the regular Timbuktu Pro icon is 
replaced with an icon that alternates between the regular Timbuktu Pro icon and an icon that
indicates which service was used to connect to your PC.

 indicates that someone connected to your PC via Exchange.

If you are receiving files from a Macintosh, the file names may be altered to conform to DOS
file naming requirements. File names with eight or fewer characters followed by an optional 
extension of three or fewer characters are unchanged. Timbuktu Pro shortens longer file 
names by removing some vowels and spaces; for example, "Newt's Syllabus.letter" becomes
"nwt'ssyl.ltt."
In addition, files may automatically receive appropriate DOS extensions, if they are 
recognized types. For more information, see Appendix B, "File Extension Mapping Tables," in 
the Timbuktu Pro for Networks User's Guide.
Translate Between Macintosh and PC Text File Formats

To stop receiving files either through Send or Exchange:

1. Display the Connections menu.
2. Choose the remote user's name under the Disconnect All Users command.
The file transfer is halted immediately. The file that was in the process of being transferred is
not copied, but all previously transferred files remain on the disk to which they were copied.

If you want to restrict other users' ability to connect to your PC, you can control individual 
user access with the Define Users command, or you can control network access with the 
User Access Privileges command. Both of these commands are located on the Setup menu.
Defining registered users
Changing the user access privileges



 Setting the drop directory
Files transferred using the Send function are stored in a drop directory. You can set the 
location of the drop directory on your PC.

To set your drop directory:

1. Choose Preferences from the Setup menu.
2. Click the Set Drop Directory button.
3. Select the drive you wish to use in the  (drive) field.
4. In the browse list, select the directory you wish to use.

If you wish to use an existing subdirectory, double-click the parent directory to 
display its subdirectories and then click the desired directory.

If you want to create a new directory for use as your drop directory, enter the drive 
letter, path (if necessary), and name for the new directory in the directory field. The 
directory field is located just above the browse list. For example, typing C:\DROP creates a 
new drop directory called DROP on your C drive.
5. Click OK to register your selection.
6. If you are creating a new directory, Timbuktu Pro asks you to confirm your decision. Click 

Yes to create the new directory.



 Moving received files and directories
To move a received file or directory:

1. Click the Move Enclosures button in the FlashNote window. The Move Enclosures dialog 
box appears.

2. If the target location for the received files is on a different disk drive, select the target 
disk from the Drives list.

3. Select a target location for the received files by choosing a directory in the Directories 
list. Move up or down through the levels of directories by double-clicking  (folder 
icons). Highlight the target directory by single-clicking on it. The name of the directory 
you select appears in the field just below the Directories list.

4. From the Enclosures list, highlight the files or directories you wish to move. If you want to
move all of the enclosed files and directories, click the Select All button at the bottom of 
the list.
Note: If you have received a directory, you cannot display the files it contains. It must be 
moved as a unit.

5. Click Move to relocate the files and directories to the chosen directory.
Note: You can also relocate the chosen files and directories by dragging them from the 
Enclosures list to the Directories list.

6. Timbuktu Pro alerts you if there is a problem with duplicate file names and ask you what 
to do. Choose the preferred course of action by clicking one of the available buttons.

7. To move other received files to different directories, repeat steps 2-5. When all of the 
files have been moved, or when you click Close, the FlashNote window will reappear.

Either discard the FlashNote or reply to it.
If you want to discard the note, click the Discard button.
If you want to reply to the note

8. Click Reply.
9. Type your response in the FlashNote window.
10. Click Send. The message is sent immediately.



 Deleting received files and directories
To delete a received file or directory:

1. Click the Delete Enclosures button in the FlashNote window. The Delete Enclosures dialog
box appears.

2. Highlight the files and directories you want to delete and click the Delete button. To 
delete all of the received files, click Select All and then click Delete.
Note: If you have received a directory, you cannot display the files it contains. It must be 
deleted as a unit.

3. Click Close when you've finished deleting files. Any files you do not delete shall remain in
your drop directory. The FlashNote window appears.

Either discard the FlashNote or reply to it.
If you want to discard the note, click the Discard button.
If you want to reply to the note

4. Click Reply.
5. Type your response in the FlashNote window.
6. Click Send. The message is sent immediately.



 Exchanging files
To use Exchange to copy files and directories to or from another computer:

1. Select a remote address from a connection tab.
Selecting a remote address

2. Click the Exchange button. Depending on the privileges you have been granted on the 
remote computer, you may need to log on.
Logging on

3. Once you have successfully connected to the remote computer, the Exchange dialog box
is displayed. The top panel in the dialog box lists the (local) drives, directories, and files 
on your PC. The bottom panel lists the same information on the remote computer.

4. Choose the destination drive.
If you're copying files from your computer to the remote disk, go to the 

 (drive) field in the bottom half of the window, click the down arrow, and choose the 
desired drive from the drop-down list.

If you're copying files from the remote disk to your computer, go to the 
 (drive) field in the top half of the window, click the down arrow, and choose the desired 

drive from the drop-down list.
5. Display the destination directory. Directories are represented by  (folder icons).

If you're copying files from your computer to the remote disk, display the destination 
directory in the lower part of the window.

If you're copying files from the remote disk to your computer, display the destination 
directory in the upper part of the window.

If the desired directory is not at the root level of the disk, you'll need to work your way 
down to it by opening additional directories. If desired, create a new destination 
directory.
Creating a new directory

6. Drag the files or directories or both from the source computer to the desired directory on 
the destination computer.

To select a group of consecutive file names, click the first name in the list, hold down 
the Shift key, and click the last file name in the list.

To select nonconsecutive files, hold down the Ctrl key and click each file name.
Timbuktu Pro begins to transfer the files immediately, with the status of the transfer 
appearing at the bottom of the Exchange dialog box. While Timbuktu Pro is transferring 
the files, you can

Click Stop to immediately cancel the transfer. The file being sent when Stop is clicked
is not transferred, but any files that were previously sent remain in the remote directory.

Click outside the Exchange window, or minimize it, to return to other tasks on your 
PC. During an Exchange transfer, you'll notice a slight slowing of performance.
7. When you have finished exchanging files, click the Close button.
Note: If you are exchanging files with a Macintosh, the names of the files you receive from 
the Macintosh may be altered to conform to DOS file naming requirements.
Receiving files from a Macintosh
You can also transfer files to a remote computer while controlling or observing it.
Transferring files during a remote control session

To use Exchange to remove files and directories from another computer:

1. Select the desired address and click the Exchange button.



2. In the remote user's panel of the Exchange dialog box, open the necessary drive and 
directory and select the file or subdirectory you want to remove.

3. Display the File menu by clicking the File menu box in the upper left corner of the 
Exchange window.

4. Choose Delete. Timbuktu Pro displays a message asking you to confirm your decision.
5. To remove the file, click Yes. To cancel the deletion, click No.
If the Exchange service turns down your file transfer request, it means one of four things:

The Exchange privilege you tried to use is not granted to your user account on the 
remote computer.

Timbuktu Pro is not running on the computer you are trying to contact.
If you are using IP, the IP address of the remote computer may be incorrect.
Another user is connected to that computer.



 Creating a new directory
When exchanging files, it is sometimes useful to create a new directory on the disk that will 
receive the files. This will keep the transferred items separate from similarly named ones 
already on the recipient's disk.

To create a new directory:

1. In the Exchange window, select the drive and open the directory that is to contain the 
new directory.

2. Click the File menu box, in the upper left corner of the Exchange window, to display the 
File menu.

3. Choose Create Directory. Timbuktu Pro asks you to name the new directory.
4. Enter the name of the new directory and click OK to create the new directory. Timbuktu 

Pro creates and opens the new directory.



 Remote control
Timbuktu Pro provides two remote control services: Control and Observe. You can use a 
service either by clicking its button in the main Timbuktu Pro window or by choosing its 
command from the Services menu. Notice that each service is enabled only if an address is 
selected in a connection tab.

Click Control to operate another user's 
computer. When you're controlling, your 
mouse and keyboard work as if they were 
directly connected to the other computer. You
can also send or exchange files with that 
computer while controlling.

Click Observe to look at another user's 
computer desktop. When you're observing, 
you can watch the activity on the desktop, 
but you cannot affect his or her computer in 
any way.

Click an icon to jump to its procedure.

To display other areas of the other computer's desktop, you can
Move your pointer in the desired direction. Timbuktu Pro scrolls the window 

automatically. If you want to switch off this autoscrolling function, click that window's 
Control-menu box to open the Control menu and deselect Auto Scrolling.

Use the scroll bars.
Drag a corner or a border of the window to enlarge it.
Click the Maximize button. The Maximize button changes to a Restore button. To 

restore the window to its previous size, click the Restore button.
The subtopics under Remote control:
Controlling another computer
Observing another computer
Transferring files during a remote control session



 Controlling another computer
To control another user's computer:

1. Select the address of the computer you want to control.
Selecting a remote address

2. Click the Control button. Timbuktu Pro displays the other computer's desktop in a Control
window. While the Control window is active, you can use your mouse and keyboard to 
operate the other computer. Clicking in a Control window makes it the active window. To 
return to your own PC, click outside the Control window.

3. To stop controlling, choose Close from the Control menu of the Control window. Timbuktu 
Pro closes the window and ends the connection.

Note: Timbuktu Pro does not support the full-screen mode of the MS-DOS Prompt. Press 
Alt+Enter to shift the MS-DOS Prompt from full-screen mode to windowed mode.

If Timbuktu Pro turns down your request to control, it means one of four things:
The Control privilege is not granted to your user account on the remote computer.
Timbuktu Pro is not running on the computer you are trying to contact.
If you are using IP, the IP address of the remote computer may be incorrect.
Another user is connected to that computer. Two users cannot control the same 

computer simultaneously.
You can also transfer files to a remote computer while controlling it.
Transferring files during a remote control session
Note: If another user is controlling your PC while Timbuktu Pro is minimized, the regular 
Timbuktu Pro icon is replaced with an icon that alternates between the regular Timbuktu Pro 
icon and an icon that indicates the presence of a controller.

 indicates that someone connected to your PC via Control.
If you would like to enable or disable the Control privilege on your computer, you can do so 
in the Define Users dialog box.
Defining registered users

If you are controlling a Macintosh that has been equipped with more than one monitor, you 
can choose which monitor is to be displayed in your Control window.

To switch between multiple Macintosh monitors:

Hold down the Shift, Ctrl, and Alt keys while pushing the left or right arrow key.
Repeating these keystrokes steps you through the loop of available monitors on the remote 
Macintosh.
Note: Macintosh keyboard equivalents are listed in the Keyboard Shortcuts section. To view 
them, click the Shortcuts button at the top of this Help window.



 Transferring files during a remote control session
Timbuktu Pro lets you copy files to or from another computer while you are controlling or 
observing it.

To transfer files while controlling or observing another computer:

1. Click the Control-menu box in the upper left-hand corner of the Timbuktu Pro Control or 
Observe window. The Control menu will appear.

2. Choose Exchange or Send, as desired, from the Control menu.
3. When the Exchange or FlashNote window appears, follow the normal exchange or send 

procedure. By default, the computer you are controlling or observing will be selected as 
the target.
Exchanging files
Sending FlashNotes and files

If Timbuktu Pro turns down your request to transfer files, it means that the Exchange or Send
file transfer privilege you requested is not granted to your user account on the remote 
computer.



 Observing another computer
To observe another user's computer:

1. Select the address of the computer you want to observe.
Selecting a remote address

2. Click the Observe button. Timbuktu Pro displays the other computer's desktop in an 
Observe window.

3. To stop observing, choose Close from the Control menu of the Observe window. Timbuktu
Pro closes the window and ends the connection.

Note: Timbuktu Pro does not support the full-screen mode of the MS-DOS Prompt. Press 
Alt+Enter on the keyboard of the computer that is being observed to shift the MS-DOS 
Prompt from full-screen mode to windowed mode.

If Timbuktu Pro turns down your request to observe, it means one of four things:
The Observe privilege is not granted to your user account on the remote computer.
Timbuktu Pro is not running on the computer you are trying to contact.
If you are using IP, the IP address of the remote computer may be incorrect.
Another user is connected to that computer. Two users cannot observe the same 

computer simultaneously.
You can also transfer files to a remote computer while observing it.
Transferring files during a remote control session
Note: If another user is observing your PC while Timbuktu Pro is minimized, the regular 
Timbuktu Pro icon is replaced with an icon that alternates between the regular Timbuktu Pro 
icon and an icon that indicates the presence of an observer.

 indicates that someone connected to your PC via Observe.
If you would like to enable or disable the Observe privilege on your computer, you can do so 
in the Define Users dialog box.

Defining registered users
If the computer you are observing is a Macintosh with more than one monitor, you cannot 
choose which monitor is to be displayed in your Observe window. You can switch the monitor
view only when controlling a Macintosh equipped with multiple monitors.



 Security
A Timbuktu Pro user can connect to your computer as a registered user, a guest user, a 
temporary guest, or as the site administrator. You can wield a vast amount of control over 
the privileges -- Send, Exchange, Control, and Observe -- that a user can exercise on your 
PC. This control can be applied at the network level by changing the user access privileges 
to your PC, or this control can be applied on a user-by-user basis by defining registered users
individually.
To control the ways in which other Timbuktu Pro users can connect to your PC, you can

Use the User Access Privileges command in the Setup menu to switch access to your 
PC off for NetWare and TCP/IP networks. This allows you to use Timbuktu Pro's services 
without allowing others to connect to your PC.

Changing the user access privileges
Set the access requirements for your guest users and registered users to the degree 

of security you require with the Define Users, Password Requirements, and Preferences 
commands in the Setup menu.

Defining registered users
Adding, changing, and removing registered users
Setting password requirements for registered users
Setting your preferences

Use the Connections menu commands to grant temporary guest access to your PC, 
disconnect a current user, clear previous users from the user log, or view the activity log.

Admitting a temporary guest
Disconnecting a guest
Clearing previous users
Checking the activity log

If you want to leave your PC as accessible to other Timbuktu Pro users as it is to you, you 
can allow unrestricted guest access.
Allowing unrestricted guest access
The topics listed below provide information on the various ways in which you can tailor your 
user privileges.
Other subtopics under Security:
Changing your user password
Entering your master password
Exiting Timbuktu Pro
Logging on
Setting your master password



 Changing the user access privileges
The User Access Privileges dialog box

Provides a convenient on/off switch for access to your PC
Summarizes the privileges you are currently granting to guest users, temporary 

guests, and registered users
Displays your current NetWare and TCP/IP addresses

To set user access for your computer:

1. Choose User Access Privileges from the Setup menu.
2. In the dialog box, select the check box for network access: NetWare, TCP/IP, or both. A 

dimmed transport name indicates that the corresponding network is not currently 
running on your PC.

When User Access is switched off for a network, other users cannot connect to your PC using
that network, but you still retain the ability to connect to other computers.
Note: Switching User Access on does not automatically grant other users access to your 
computer. You will need to specify which users can connect to your PC by setting appropriate
privileges for the various categories of users.
Adding, changing, and removing registered users

Privilege Summary
This section indicates the numbers and types of users to which you have granted the Send, 
Exchange, Control, and Observe privileges. For example, if the summary looks like this:

Guest Users can Send FlashNotes and 
files to your machine
2 Users can Exchange files with your 
machine
1 User can Control your machine

2 Users can Observe your machine

it means that any user can send FlashNotes, files, and directories to you at any time. 
However, you have granted the Exchange, Control, and Observe privileges only to registered
users and temporary guests. Restricted access is indicated by the presence of a key icon to 
the left of the privilege icon.
My Network Addresses
If you have installed the NetWare and/or the TCP/IP protocol on your PC, this section 
indicates your network address(es). If you are using only one of these protocols, the other 
protocol's name is dimmed.



 Defining registered users
Each registered user must be defined by a name, a password, and one or more access 
privileges:
Name field: Type in the user name that, along with a password, the registered user must use 

when he or she wants to connect to your computer.
Password field: Type in the password that, along with a user name, the registered user must 

use when he or she wants to connect to your computer. Following the initial log-in, the 
user is free to change the password as long as the replacement password conforms to 
any requirements set by you.

Confirm field: Type the password again, just to make sure you got it right the first time.
Privilege check boxes: Check the specific privileges you wish to grant to the selected user.

Send           Copy To (Write)
Control           Copy From (Read)
Observe           Remove

New User button: Click New User to add a new registered user to the user name list.
Delete: Click Delete to remove the selected registered user.
When you select <Guest> and <Temporary Guest> entries, the Password, and Confirm 
fields disappear. Those fields are not used for the guests or temporary guests.
Privileges you define for <Guest> are automatically granted to all registered users as well. 
For example, if you grant the Send privilege to <Guest>, you cannot deny this privilege to 
registered users.



 Adding, changing, and removing registered users
The following procedures show you how to add a registered user, how to change the user 
names and passwords, and how to remove registered users. More background information 
on privileges and types of users is contained in the Overview section.
How secure can I be?

To add a new user:

1. Choose Define Users from the Setup menu.
Defining registered users

2. Click the New User button. Timbuktu Pro adds a registered user entry called New User.
3. In the Name field, type in the desired user name in place of New User.
4. Press Tab to move to the Password field.
5. Type the password.
6. Press Tab to move to the Confirm field.
7. Retype the password exactly as you typed it before.
8. Press Tab to move to the Privileges panel.
9. If you have arrived at a privilege you wish to grant to this registered user, click it or press

the Spacebar.
Send           Copy To (Write)
Control           Copy From (Read)
Observe           Remove

10. Continue to press Tab to move through the privileges, pressing the Spacebar to select (or
deselect) privileges.

11. Define additional new users, if desired, by repeating steps 2-10.
12. Click OK to save the new entries and close the dialog box.
To change a user entry:

1. Choose Define Users from the Setup menu.
2. Select the desired user in the list on the left side of the dialog box.
3. To change the name or password, select it, then type the new value. If you change the 

password, you will have to type it again in the Confirm field.
4. To change a privilege, click its check box.
5. Click OK to save your changes and close the dialog box.
To remove a user entry:

1. Choose Define Users from the Setup menu.
2. Select the desired user in the list on the left side of the dialog box.
3. Click the Delete button in the dialog box. (The Delete key on the keyboard only deletes 

the text in the selected text field.)
4. Click OK.



 Setting password requirements for registered users
The first time a registered user connects to your PC, he or she must enter the user name 
and password exactly as you specified them in the Define User dialog box. Thereafter, the 
password can be changed at any time without your permission.
Defining registered users
However, registered users are not necessarily free to type in any new passwords they 
please. You can impose the following limitations on the kinds of Timbuktu passwords that 
your computer accepts.
Logging on
To set password requirements for registered users:

1. Select the Password Requirements command from the Setup menu. The Set Password 
Requirements dialog box appears.

2. You can select any combination of the requirements listed below to impose limitations on
how your registered users can modify their passwords:
Password must be at least  characters long. Enter a number in the field to define a 
minimum password length. When this option is checked, Timbuktu Pro rejects any new 
password that is shorter than the specified length.

Password expires after  days. Enter a number in the field to define the number of days 
each new password is to remain valid. When this option is checked and the specified number
of days have passed, Timbuktu Pro prompts the user for a new password before allowing the 
connection.

Password cannot match three previous passwords. When this option is checked, 
Timbuktu Pro rejects any new password that matches any of the user's previous three 
passwords. The user must enter a valid password or cancel the Change Password dialog 
box.
Password cannot be any of the following: When this option is checked, Timbuktu Pro 
rejects any new passwords that can be easily guessed. The user must enter a valid 
password before he or she can connect. This option rules out the following classes of 
passwords:

The user's first name, last name or initials
A series of repeated letters, numbers, or symbols; for example, "555555"
A series of letters or numbers in sequence or reverse sequence; for example, 

"fedcba"
Any keyboard sequence; for example, "asdfgh"
Any day of the week, month or season name
Selected first names, sporting terms, or common words

Note: These restrictions do not apply to setting your own master password.



 Setting your preferences
You can display the Preferences dialog box by choosing Preferences from the Setup menu. It 
contains the following options:
Computer Name
The Timbuktu Pro name of your PC. This name appears in the NetWare tab of other users 
when you've made your computer available on that network.
Master Password

Password and Confirmation fields
The master password prevents anyone who is controlling your computer from displaying 
the Define Users, Password Requirements, and Preferences dialog boxes. To set a master 
password, you must type the password in both the Master Password and Confirmation 
fields. The characters of the password are always displayed as asterisks. Timbuktu Pro 
does not let you close the Preferences dialog box until the Master Password and 
Confirmation fields match. After the master password is set, Timbuktu Pro asks you to 
enter it before displaying the Define Users, Password Requirements, or Preferences 
dialog boxes.
Setting your master password

Drop Directory
Location
This tells you where the files transferred to your PC by another Timbuktu Pro user via the 
Send command are saved. The default path is C:\FILES. This path can be changed by 
clicking the Set Drop Directory button, described below.

Set Drop Directory button
Click this button to display the Set Drop Directory dialog box. You can then specify the 
directory where Timbuktu Pro puts the files transferred to your PC using the Send 
service. Select the directory you wish to use, then click OK.
Setting the drop directory

Protect  Megabytes of disk space from use by drop directory
To limit the amount of disk space consumed by files sent to your drop directory, enter an 
appropriate number in this field. This number defines the amount of disk space that you 
always want to keep free from use by the Send service. This option does not restrict files 
transferred using the Exchange service.
General Options

Show FlashNotes
Selecting Full Size in a Window causes an incoming Timbuktu Pro FlashNote to be 
displayed as soon as it arrives.
Selecting As a Minimized Icon causes the FlashNote to be displayed as an icon on the 
desktop, as a reminder that a message has arrived.

Remote Control Window
Selecting Auto Scroll causes Timbuktu Pro to scroll a remote control window 
automatically when your mouse pointer approaches the edge of the window, or when the
pointer on the displayed desktop moves out of view.



Selecting Use Scroll Bars cancels the automatic scrolling described above.
Note: Since there are no scroll bars when a Control or Observe window is maximized, a 
maximized window always scrolls automatically.
Display Wallpaper While Being Controlled or Observed
When this option is switched off, the Windows Wallpaper is removed from the desktop of 
your PC whenever another Timbuktu Pro user is controlling or observing your computer. 
Shutting off the wallpaper should increase the speed of Timbuktu Pro. The Wallpaper 
reappears when the remote control session ends.

Translate Between Macintosh and PC Text File Formats
Selecting this option causes Timbuktu Pro to translate end-of-line characters correctly 
when you send or exchange text files between Windows and Macintosh computers. If the 
option is deselected -- the default setting -- Timbuktu Pro doesn't alter these files.
In Macintosh text files, the end of each line is signified by a carriage return character. In 
PC text files, it is represented by a carriage return character plus a line feed character.
Note: FlashNotes are always translated when sent to a Macintosh. They are assigned 
Type TEXT, Creator T$2a, and are named "Timbuktu Pro Note."

Shared Address Book
Location
This tells you the name and location of your Shared address book.

Set Shared Address Book
Clicking this button brings up the Set Shared Address Book dialog box. You can use a 
shared address book on any available local or network drive.
Setting the Shared address book



 Setting your master password
The Master Password prevents other users from displaying the Define Users, Password 
Requirements, and Preferences dialog boxes. The characters of the password are always 
displayed as asterisks.

To set the master password:

1. Choose Preferences from the Setup menu. 
2. Click the Master Password field and type a password.
3. Tab to the Confirm field (or click the field with the mouse).
4. Type the password exactly as you did in the Master Password field.
5. Click OK to exit the Preferences dialog box and add the master password to the 

Preferences file. (You can also make other changes to the preferences before exiting the 
dialog box.)
Note: Timbuktu Pro does not let you close the Preferences dialog box until the two 
passwords are identical or both fields are blank.



 Entering your master password
If a Master Password is defined in the Preferences dialog box, Timbuktu Pro asks you to enter
it before displaying the Define Users, Password Requirements, or Preferences dialog boxes.

To enter a master password:

1. Type the master password in the Password field exactly as it was entered in the Master 
Password and Confirm fields of the Preferences dialog box.

2. Click OK.



 Allowing unrestricted guest access
Caution: This procedure grants all privileges, including deleting files, to any Timbuktu Pro 
user on the network without password protection.

To allow all Timbuktu users unrestricted access to your computer:

1. Choose Define Users from the Setup menu.
Defining registered users

2. Select the <Guest> entry.
3. Select all of the privileges.
4. Click OK to save the new <Guest> privileges.



 Admitting a temporary guest
The Admit Temporary Guest command allows you to grant temporary access to Timbuktu Pro
users who are not among your registered users.

To admit a temporary guest:

1. Choose Define Users from the Setup menu.
2. Make sure the <Temporary Guest> entry has been granted the privileges your guest 

needs when he or she connects to your PC.
Changing the user access privileges

3. Arrange an appointment with the user that wants to connect to your computer.
4. At the appointed time, choose Admit Temporary Guests from the Connections menu. This

gives the other user one-time access to your computer.
5. When the guest user connects to your PC, the guest's Timbuktu name is displayed in the 

Admit Temporary Guests dialog box along with the privilege he or she has selected.
6. Click OK to begin the attended access session.
7. You can always terminate a session if the unexpected occurs. For example, if a guest 

connects with a privilege you are not expecting -- Control instead of Observe -- click 
Cancel to break the connection.



 Disconnecting a guest
To disconnect a guest and stop file transfers, Control, or Observe sessions:

1. Display the Connections menu.
2. Choose the desired name from the list of remote users below Disconnect All Users. You 

can also disconnect all guests by choosing Disconnect All Users.
Note: You can also disconnect all of the users when Timbuktu Pro is minimized by clicking
on the Timbuktu Pro icon and selecting Disconnect All Users from the Control menu.



 Clearing previous users
Previous users are users who were once connected to your PC but either have completed 
their tasks or have been disconnected by you.

To clear the list of previous users:

1. Display the Connections menu.
2. Choose Clear Previous User Log. The names that were listed below the command are 

deleted.
Note: You can also clear the previous user log when Timbuktu Pro is minimized by 
clicking on the Timbuktu Pro icon and selecting Clear Previous User Log from the Control 
menu.



 Logging on
You can connect to a remote computer either as a guest, as a temporary guest, or as a 
registered user.

When you connect to another computer as a guest, you are granted immediate 
access to the remote computer via the service you select. No additional steps are necessary.

When you connect to another computer as a temporary guest, you have to wait until 
the user of the remote computer allows you to connect. A dialog box appears, indicating that
you are waiting for the user of the remote computer to allow you to connect.

When you connect to another computer as a registered user and if you have been 
assigned a password on that computer, you must go through a log-on procedure.
To log on to another computer as a registered user:

1. Connect to a remote computer using one of Timbuktu Pro's services. If you have been 
assigned a password on the remote computer, the Log On dialog box appears.

2. Your Timbuktu Pro user name is entered in the Name field automatically. If necessary, 
type a different name in the Name field.

3. Press the Tab key.
4. Type your password in the Password field.
5. Click OK.
6. If your credentials are verified, you are allowed to connect to the remote computer. Click 

Cancel if you want to cancel you connection attempt.
If you want to change your user password, click the Set Password button.
Changing your user password



 Logging on
You can connect to a remote computer either as a guest, as a temporary guest, or as a 
registered user.

When you connect to another computer as a guest, you are granted immediate 
access to the remote computer via the service you select. No additional steps are necessary.

When you connect to another computer as a temporary guest, you have to wait until 
the user of the remote computer allows you to connect. A dialog box appears, indicating that
you are waiting for the user of the remote computer to allow you to connect.

When you connect to another computer as a registered user and if you have been 
assigned a password on that computer, you must go through a log-on procedure.
To log on to another computer as a registered user:

1. Connect to a remote computer using one of Timbuktu Pro's services. If you have been 
assigned a password on the remote computer, the Log On dialog box appears.

2. Your Timbuktu Pro user name is entered in the Name field automatically. If necessary, 
type a different name in the Name field.

3. Press the Tab key.
4. Type your password in the Password field.
5. Click OK.
6. If your credentials are verified, you are allowed to connect to the remote computer. Click 

Cancel if you want to cancel you connection attempt.
A dialog box may appear offering you the option of logging on as either a Guest user, a 
Registered User, or as a Password-Only User. If you want to make sure that you log on in a 
specific category, select that option.
If you want to change your user password, click the Set Password button.
Changing your user password



 Checking the activity log
The activity log contains a list of the Timbuktu Pro tasks users have performed on your PC. 
This list can be useful as a record of file transfers from users, and can be used to help 
diagnose problems you encounter when using the software. Each line of the activity log 
contains the following:

A date
A time
The service used
Whether this event was the beginning or ending of the session
The network protocol used
The user name
The computer name
The network address

To view and save the activity log:

1. Choose See Activity Log from the Connections menu. The Activity Log window appears.
If you'd like a copy of the log
2. Click Save As.
3. Type a name for the log.
4. Select the destination directory.
5. Click OK.



 Changing your user password
To change your user password:

1. After the Log On dialog box is displayed, click the Set Password button. The Change 
Password dialog box will appear.
Logging on

2. Type your current password in the Old Password field.
3. Type your new password in the New Password field.
4. Type the new password again in the Confirm field.
5. Click OK.
Note: The remote user may have placed restrictions on the kinds of passwords that he or 
she allows. Your new password must meet these requirements.
Setting password requirements for registered users



 Exiting Timbuktu Pro
When you shut down the application, other Timbuktu Pro users cannot connect to your PC.
Timbuktu Pro will not allow you to shut down while you are in the process of transferring 
files. Before you can shut down Timbuktu Pro, you'll need to display any file transfer 
windows, click the Stop button, and then click the Cancel button.

To quit Timbuktu Pro:

Choose Exit from the File menu.
Choose Shut Down Timbuktu Pro from the Control menu of the Timbuktu Pro icon.



 How to ...
Here is an alphabetical listing of all the step-by-step procedures covered in Timbuktu Pro for 
Networks online Help.
Add, change, and remove registered users
Add addresses
Admit a temporary guest
Allow unrestricted guest access
Change the user access privileges
Change your user password
Check the activity log
Clear previous users
Control another computer
Define registered users
Delete addresses
Delete received files and directories
Disconnect a guest
Enclose files in a FlashNote reply
Enter your master password
Exchange files
Exit Timbuktu Pro
Export addresses
Import addresses
Log on
Move received files and directories
Observe another computer
Receive FlashNotes and files
Select a remote address
Select files to send
Send FlashNotes and files
Send from the File Manager
Set password requirements for registered users
Set the drop directory
Set the Shared address book
Set your master password
Set your preferences
Transfer files during a remote control session
Use Remote Connection Files



 Connection tabs
You use the connection tabs -- Personal, Shared, TCP/IP, and NetWare -- to select the 
Timbuktu Pro user you wish to communicate with.
Two of the connection tabs in the main window display information from Timbuktu Pro files 
called address books.

The personal address book, displayed by the Personal connection tab, is a collection 
of Timbuktu Pro addresses that you can edit and compile either by importing addresses from
a text file or by adding addresses from a different connection tab. You can also export 
addresses to text files. Exported text files can be used by other Timbuktu Pro users to 
quickly and easily add new addresses to Timbuktu Pro.

The shared address book, displayed by the Shared connection tab, can be read from 
your hard disk or from a network server. The shared address book is a list of Timbuktu Pro 
addresses that is typically compiled by your network administrator. It can be edited only by 
the network administrator. You can export the shared address book, but you cannot import it
or add to it.
The other two connection tabs let you access NetWare or TCP/IP network addresses that may
not appear in either of your address books. Notice that you must be running the appropriate 
network protocols for these tabs to appear in Timbuktu Pro.

The NetWare connection tab lists users who are currently running Timbuktu Pro and 
have switched on NetWare in the User Access dialog box. Clicking the Search button causes 
Timbuktu Pro to update your NetWare browse list.

The TCP/IP connection tab requires you to enter a valid TCP/IP network address to 
make a connection. The TCP/IP protocol does not allow Timbuktu Pro to browse for the 
names and addresses of computers on your IP network.
Each connection tab also features an Address Book area that contains Add and Delete 
buttons.

The Add button allows you to select an address from one of the network tabs and 
quickly add it to your personal address book.

The Delete button is an easy way to delete addresses from your personal address 
book.
These buttons will be active or dimmed, depending on which connection tab you are in and 
what has been selected.
Note: The fact that a remote address appears in an address book does not guarantee that 
the user at that address is currently running Timbuktu Pro. If Timbuktu Pro is not running, 
you won't be able to set up a connection. In addition, some TCP/IP addresses are dynamic -- 
they can be automatically reassigned to computers other than the ones appearing in your 
address book.
The subtopics under Address books:
Adding addresses
Deleting addresses
Exporting addresses
Importing addresses
Selecting a remote address
Setting the Shared address book

Establishing dial-in connections
When Timbuktu Pro detects that you have PPP dial-in client software installed on your PC, 
the Dial Remote Network and Remote Connection Files commands are enabled in the 
Connections menu. This allows you to log on to a computer network across a telephone line. 



Once logged on, your connection tabs operate just as if your computer was running on the 
local network. Check with your network administrator and your PPP dial-in client software 
documentation before using the Dial Remote Network command.
If you have a library of remote connection files to draw on, the Remote Connection Files 
command in the Connections menu allows you to quickly establish a dial-in connection to a 
remote network.
The subtopic under Establishing dial-in connections:
Using Remote Connection Files



 Selecting a remote address
Before you can send or exchange files, you must select the computer you wish to 
communicate with and determine whether you have been granted access to that computer. 
The following three procedures show you how to select an address in an address book, 
select an address in a NetWare connection tab, and enter an address in the IP connection 
tab.

Selecting a destination from an address book
Selecting a NetWare destination
Selecting an IP destination
To display one of these subjects, you can either scroll through this section or you can jump 
directly to specific information by clicking on the name of a subject.

To select a destination from an address book:

1. Display Personal tab or the Shared tab, as desired.
2. Scroll as necessary to find the desired Timbuktu Pro user.

If the computer you're looking for is in the address book, highlight the computer 
name.

If the computer you're looking for is not listed in an address book, you can either 
browse for it in the NetWare tab or type its IP address or IP name in the TCP/IP tab, as 
described below.

Note: For the Send function only, you can use the Ctrl key or the Shift key to select a 
group of non-consecutive or consecutive computer names from an address list.

If you are selecting an address from the main window, the destination selection process is 
complete.
If you are selecting destinations from the Select Timbuktu Addresses dialog box:
3. Click the Add button. The chosen address appears in the list of destinations at the 

bottom of the window. You can add a group of non-consecutive or consecutive computer 
names from the address book by selecting them while holding down the Ctrl key or the 
Shift key.

4. If you are finished selecting destination addresses, skip to step 6.
Timbuktu Pro allows you to mix the types of addresses -- NetWare and IP -- in the list of 
destinations. If you want to select another recipient, click the tab -- address book, 
NetWare, or IP -- that contains the network address you want.

5. Follow the address selection procedure given for the tab you chose.
6. Click the OK button to return to the FlashNote window.
To select a NetWare destination:

1. Click the NetWare tab.
Note: If you do not have a NetWare tab, it means that your computer is not currently 
running NetWare.

2. Click the Search button to display the Timbuktu Pro addresses available on your Novell 
network. Scroll as necessary to find the desired address. The NetWare address search 
option is also available:

You can filter out all but the NetWare user names that begin with a specific sequence 
of characters. To do so, type the search string of characters into the field below the user 
name list and click the Search button. Names that begin with the same series of characters 
will appear in the user name list. For example, to search for all Timbuktu Pro users on 
NetWare with computer names starting with "Ji", type "ji" in the edit field. This will display 
such names as "Jill Smith," "Jim Williams," and "jitney."    The search does not distinguish 
between uppercase and lowercase letters.



To have Timbuktu Pro perform a more aggressive NetWare address search, hold down
the Shift key while clicking the Search button.
3. Highlight the desired recipient.

Note: For the Send function only, you can use the Ctrl key or the Shift key to select a 
group of non-consecutive or consecutive computer names from the NetWare address list.

If you are selecting an address from the main window, the destination selection process is 
complete.
If you are selecting destinations from the Select Timbuktu Addresses dialog box:
4. Click the Add button. The chosen address appears in the list of destinations at the 

bottom of the window. You can add a group of non-consecutive or consecutive computer 
names from the NetWare address list by selecting them while holding down the Ctrl key 
or the Shift key.

5. If you are finished selecting destination addresses, skip to step 7.
Timbuktu Pro allows you to mix the types of addresses -- NetWare and IP -- in the list of 
destinations. If you want to select another recipient, click the tab -- address book, 
NetWare, or IP -- that contains the network address you want.

6. Follow the address selection procedure given for the tab you chose.
7. Click the OK button to return to the FlashNote window.
To select an IP destination:

1. Click the TCP/IP tab.
Note: If you do not have a TCP/IP tab, it means that your computer is not currently 
running TCP/IP.

2. Enter the IP address or IP name of the remote computer. TCP/IP does not let you browse 
for the names and addresses of computers on your IP network. If you do not know the 
address, you will need to get it from the owner of the other computer or from your 
network administrator.

If you are selecting an address from the main window, the destination selection process is 
complete.
If you are selecting destinations from the Select Timbuktu Addresses dialog box:
3. Click the Add button. The chosen address appears in the list of destinations at the 

bottom of the window.
4. If you are finished selecting destination addresses, skip to step 6.

Timbuktu Pro allows you to mix the types of addresses -- NetWare and IP -- in the list of 
destinations. If you want to select another recipient, click the tab -- address book, 
NetWare, or IP -- that contains the network address you want.

5. Follow the address selection procedure given for the tab you chose.
6. Click the OK button to return to the FlashNote window.



 Adding addresses
Choosing Add Addresses allows you to copy an address from the NetWare or TCP/IP tab to 
your personal address book.

To copy an address to your personal address book:

1. Click the NetWare tab and select the desired address, or click the TCP/IP tab and type the
IP name or IP address.

2. Click the Add button in the Address Book section of the connection tab.
Note: You can also add an address by choosing Add Address from the Edit menu.
Timbuktu Pro attempts to contact the chosen computer to verify information and fill in 
the fields of this dialog box. This may take a few seconds. The Add to Personal Address 
Book dialog box appears. If the remote computer wasn't available, Timbuktu Pro displays 
default information.

3. If desired, edit the Description, Computer Name, and Address fields. The Computer 
Platform can be switched between Macintosh and MS Windows as well.

4. Click OK to complete the procedure.



 Deleting addresses
Choosing Delete Addresses allows you to remove the address selected in your personal 
address book.

To delete an address from your personal address book:

1. Click the Personal tab and select the address you wish to delete.
2. Click the Delete button in the Address Book section of the connection tab.

Note: You can also delete an address by choosing Delete Address from the Edit menu.



 Importing addresses
Choosing Import Addresses allows you to copy information into your personal address book 
from an address file created by the Export Address command. Importing addresses does not 
remove existing entries and does not import addresses that are identical to ones already 
contained in your personal address book.
You cannot import addresses to your shared address book.

To import an address book:

1. Choose Import Addresses from the File menu. The Import Addresses From Text File dialog 
box appears.

2. In the  (drive) field, select the drive that contains the address file you want to use. Do 
this by clicking on the drop-down menu arrow and selecting a name from the list of 
available drives. If you need to change your network settings to access the drive you 
desire, click the Network button.

3. Select the directory that contains the file. Double-click on  (folder icons) to move up 
or down through the directory levels.
4. If necessary, select the file type by clicking the drop-down menu button in the List Files 

of Type field. By default, the file type is text (.TXT). Since a Timbuktu Pro address book 
file is normally exported with a .TXT extension, this should allow you to view the 
available address book files.
The extension on the text file you wish to import may be something else. In that case, 
click the List Files of Type drop-down menu and select All Files. This causes Timbuktu Pro 
to display all the files in that directory.

5. Choose the file you want from the File Name list.
6. Click OK to import the file. Timbuktu Pro copies the addresses from the selected file to 

your personal address book.



 Exporting addresses
Choosing Export Addresses allows you to copy information from either your personal address
book or your shared address book to a text file. Other Timbuktu Pro users can then import 
these addresses.

To export a new personal or shared address file:

1. Select the tab -- either Personal or Shared -- from which you are going to export the 
address file.

2. Choose Export Addresses from the File menu. The Export Addresses To Text File dialog 
box appears.

3. In the  (drive) field, select the drive that is to store your exported file. Do this by clicking
on the drop-down menu arrow and selecting a name from the list of available drives. If 
you need to change your network settings to access the drive you desire, click the 
Network button.

4. Select the directory that will contain the file. Double-click on  (folder icons) to move up 
or down through the directory levels.

5. In the File Name field, type the desired name -- for example, EXPORT.TXT -- for the 
exported address file. Timbuktu Pro saves the address file as a text (.TXT) file.

Note: It is a good idea to use .TXT as the extension on your exported file. This 
minimizes the confusion between the various file types that you may find in your directory.
6. Click OK. Timbuktu Pro creates the export file and saves it in the specified location.



 Setting the Shared address book
To set the location of the shared address book:

1. In the  (drive) field, select the drive that contains the shared address file you want to 
use. Do this by clicking on the drop-down menu arrow and selecting a name from the list 
of available drives. If you need to change your network settings to access the drive you 
desire, click the Network button.

2. Select the directory that contains the file. Double-click on  (folder icons) to move up 
or down through the directory levels.
3. If necessary, select the file type by clicking the drop-down menu button in the List 
Files of Type field. By default, the shared address book file type .TAB (Timbuktu Address 
Book).

The extension on the shared address book file you wish to import may be something 
else. In that case, click the List Files of Type drop-down menu and select All Files. This 
causes Timbuktu Pro to display all the files in that directory.

4. Choose the file you want from the File Name list.
5. Click OK to register your changes. The new shared address book won't be used until you 

have quit and restarted Timbuktu Pro.



 Using Remote Connection Files
The Remote Connection Files command in the Connections menu allows you to easily select 
a remote network dial-in connection file.

To select a remote network connection file:

1. Select Remote Connection Files from the Connections menu. The Remote Connection 
Files dialog box appears.

2. Highlight the connection file name you want to use. The name and its path appear in the 
connection file field above the browse list.

3. Click OK to open the connection file.
Note: You can also open a connection file by double-clicking the connection file name



 Menus
File Edit Setup
Import Addresses Cut Define Users
Export Addresses Copy User Access 

Privileges
Exit Paste Password 

Requirements
 Add Address Preferences

Delete Address

Services Connections Help
Send Dial Remote Network Contents
Exchange Remote Connection 

Files
How to use Help

Control Admit Temporary 
Guest

About Timbuktu Pro

Observe Activity Log
Disconnect All Users  
Clear Previous User 
Log

 Keyboard shortcuts
Keyboard shortcuts for Timbuktu Pro are listed below, beginning with the shortcuts for the 
main window, and continuing with the shortcuts for individual menus.
If you are connected to a Macintosh, you may want to familiarize yourself with the Macintosh
keyboard equivalents.
When controlling a Macintosh

Note: If you type a keyboard shortcut while you are controlling another computer and a 
Control window is active, the shortcut is carried out on the other computer only.

Commands that work anywhere
in Timbuktu Pro:

Action Shortcut

View context-sensitive 
help

F1

Close any menu Alt
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Close the window Alt+F4
Switch to another 
Windows application

Ctrl+Esc

Commands that work in the Timbuktu
Pro

main window:



Send Ctrl+S
Exchange Ctrl+E
Control Ctrl+T
Observe Ctrl+O
Display the File menu Alt+F
Display the Edit menu Alt+E
Display the Setup menu Alt+T
Display the Services 
menu

Alt+S

Display the Connections 
menu

Alt+C

Display the Help menu Alt+H
Select the Personal 
connection tab

Alt+P

Select the Shared 
connection tab

Alt+A

Select the TCP/IP 
connection tab

Alt+I

Select the NetWare 
connection tab

Alt+N

Close the application Alt+F4

File menu commands:

Import addresses I
Export addresses E
Exit X

Edit menu commands:

Cut T
Copy C
Paste P
Add an address to the 
personal address book

A

Delete an address from 
the personal address book

D

Setup menu commands:

Define users U
User access privileges A
Password requirements R
Preferences P

Services menu commands:



Send D
Exchange E
Control T
Observe O

Connections menu commands:

Dial a remote network R
Open a remote 
connection file

M

Admit a temporary guest A
View the activity log L

Help menu commands:

Contents C
How to use Help H
About Timbuktu Pro A

When controlling a Macintosh

To do this: Press this:

Use the Option key Alt
Use the Command

 key
Ctrl

Switch between 
monitors on a 
Macintosh

Shift+Ctrl+Alt+ 
(right or left arrow 
key)

 Troubleshooting
Troubleshooting contains sections covering the following subjects:

Troubleshooting remote control sessions
Cross-platform information
NetWare information
TCP/IP information
Exchange information
Send information
Memory information
Miscellaneous information

To display one of these subjects, you can either scroll through the troubleshooting sections 
or you can jump directly to specific information by clicking on the name of a subject.

Troubleshooting remote control sessions

Fonts are not displayed properly

Timbuktu Pro speeds up performance during control and observe sessions by sending 
minimal font information. This works properly as long as the controller or observer has the 
same fonts installed as those used on the remote computer. If that is not the case, the text 
may be displayed improperly. To work around this problem, the controller or observer can 



force Timbuktu Pro to send text as bitmaps:
1. Close the Control or Observe window in which the text was not displaying properly.
2. Using Notepad, Write, or any text editor, open the TB2.INI file, which is in your Timbuktu 

directory. Do not convert the file; it should remain in text-only format.
3. Scroll to the line that reads BMPAlways=0 and change it to BMPAlways=1.
4. Save and close the TB2.INI file.
5. Reconnect to the remote computer as a controller or observer.
Control or Observe window sometimes freezes

If you are controlling or observing a remote computer and the other computer appears to 
freeze up, check the video driver on the remote computer. Ask the remote user to switch his 
or her video mode to standard VGA or to one of the standard Super VGA drivers that ship 
with Windows 3.11. The problem may also occur if you are using a non-standard video 
driver.

Screen freezes following TCP/IP disconnection

If a person controlling or observing your computer via TCP/IP disconnects while your screen 
is being updated, the hourglass icon appears on your desktop for several seconds. Your 
screen will recover after a short period, but if you'd like it to recover immediately, press 
Ctrl+Break.

Some colors not visible in Control or Observe window

If incorrect colors appear during a remote control session between two computers, check for 
differing color capabilities. For example, if the remote computer you are observing has 256 
colors with a text highlight of light blue and your computer has only 16 colors, the light blue 
may be mapped to white in your Observe window. You won't be able to see any highlighted 
text. Ask the other user to switch to the same color depth you are using.

Screen savers

If you expect to have remote users controlling or observing your computer, it's a good idea 
to use ScreenBlank, a screen saver that ships with Windows, or no screen saver. Screen 
savers are changed in the Desktop option of the Control Panel. This will minimize the 
increased network traffic created when the screen saver images are transferred by Timbuktu
Pro.

Running DOS sessions by remote control

Note: Timbuktu Pro does not support full-screen DOS mode.
While controlling another PC, you can run a DOS session in a window. But if you try to switch 
the DOS session to full-screen mode by pressing Alt+Enter, the MS-DOS Prompt window is 
minimized, you won't be able to see the text you are typing, and you won't be able to issue 
commands from DOS. If you connect to a computer that is running Windows in full-screen 
DOS mode, redisplay the DOS session in a window by pressing Alt+Enter.
Hint: You can usually assume you have connected to a computer in a full-screen DOS session
if the remote computer displays partially drawn windows or text segments and does not 
respond to your mouse movements or keystrokes.

Cross-platform information

Overwriting files with identical names

Some Macintosh directories and files may have names that are identical to the those being 
transferred from your PC. When this happens, you get the message, "Replace items with the 



same names with the selected items?" If you click Yes, the files and directories on the PC will
overwrite those files on the Macintosh that have the same name. The original Macintosh files
will be lost.

Problems controlling a Macintosh

When a PC user is controlling or observing a Macintosh computer:
The colors in the Control or Observe window of the PC may not exactly match the 

colors on the Macintosh.
When the Macintosh is running FrameMaker 4.0, the text in the FrameMaker menus 

may not be visible to the PC controller or observer. Make sure the Macintosh user has 
switched on Support Bypassing QuickDraw in the Preferences dialog box.

Buttons on a Macintosh application may sometimes not be visible to the PC controller
or observer, but they are still functional.
Problems connecting to a Macintosh

Make sure the Macintosh user is running Timbuktu Pro for Macintosh 1.0.5 or later.

Macintosh user cannot display FlashNotes

A FlashNote, created with the Send command, is not automatically displayed on a Macintosh
running Timbuktu Pro for Macintosh 1.x. Instead, it is stored as a "Timbuktu Pro Note." A 
Timbuktu Pro Note is a text file that can be opened by any basic word processor, such as 
SimpleText.

Cross-platform passwords cannot use extended character sets

Characters that are not shared between your PC and a Macintosh cannot be used in 
passwords. Passwords that are to be used across platforms should consist of the basic 
characters that both platforms share.

NetWare information

No NetWare connection tab

If the NetWare connection tab does not appear in your Timbuktu Pro window, make sure that
NetWare is working properly outside of Timbuktu Pro. Run the Windows setup program and 
verify that the NetWare 3.x or 4.x client shell is installed. Once you have established this, try
logging on to a Novell file server from inside Windows. If you can't do that, the problem is 
more likely to be with your NetWare installation rather than with Timbuktu Pro.
Note that there is no NetBEUI connection tab in Timbuktu Pro. Although NetBEUI is the 
default network you get when you install Windows for Workgroups, Timbuktu Pro does not 
currently support NetBEUI.

Cannot see remote address in the NetWare tab

If you can't find a computer name in the NetWare connection tab, make sure that
The remote user has Timbuktu Pro running.
The remote user has selected NetWare in the User Access Privileges dialog box.
Microsoft's IPX/SPX protocol is not selected in Network Setup

If these conditions are met and you still cannot see the remote computer in the NetWare tab,
the network may be too busy. Use the wildcard look-up procedure to limit the number of 
responding computers. Type the first few characters of the remote computer's name in the 
NetWare Search box (located below the Search button), then click the Search button. The 
lookup is not case sensitive. If you still do not see the computer name, hold down the Shift 
key and click the Search button again. This forces a more aggressive search. If you are still 
unable to display the computer name, contact Farallon Technical Support.



TCP/IP information

Do not control your local computer over TCP/IP

Please do not attempt to control your own computer over TCP/IP; it will crash your system.

No TCP/IP connection tab

If the TCP/IP connection tab does not appear in your Timbuktu Pro window, first of all, make 
sure that your TCP/IP software is compatible with Timbuktu Pro. Refer to the Timbuktu Pro for
Networks Release Notes for the most up-to-date information.
If you are using an approved stack, make sure that your IP network software is working 
properly outside of Timbuktu Pro. Try other Windows Sockets IP applications, such as 
Netscape, Telnet, or ftp. If these aren't working either, the problem is more likely to be with 
your IP stack rather than with Timbuktu Pro.

Error Message: Computer Name does not match

If you connect to an address saved in your personal address book and learn that the 
Computer Name does not match, you may have saved a dynamic IP address. That address 
may have since been assigned to a different computer.

Exchange information

Simultaneous sessions not supported

You will need to take turns using the Exchange command if somebody else is already 
exchanging files with the computer you have selected. The same limitation applies to the 
Control or Observe commands. If you attempt to open another session for these services, 
you will get an error message that reads "The service you requested is busy and cannot 
accept any more connections." You will need to wait until the prior connection has ended.

Send information

Cannot send file with special characters in the name

You cannot send a file with certain diacritical marks in the file name. For example, the file 
Béta.txt cannot be transferred using the Send command. An error is displayed when you try 
to add it as an enclosure. You can work around this by putting the file in a directory and then
sending the directory, or you can rename the file before sending it.

Cannot reply to FlashNote

Unlike sending electronic mail, sending FlashNotes requires the sender and receiver to be 
running Timbuktu Pro at the same time. If you are unable to reply to a FlashNote from 
another Timbuktu Pro user, check to see if the other user has switched off Timbuktu Pro.

Send command sometimes fails to transfer files within large directory enclosures

If you include a directory as an enclosure in a FlashNote and if that directory goes many 
levels deep, Timbuktu Pro may not be able to transfer some of files in the lower levels of the 
directory.
For example, you include the c:\sales directory in a FlashNote, and within that directory, you 
go as deep as
c:\sales\southern\quarter4\phase2\hardware\copper\judy\data\sales.doc.
This path is less than the maximum 64-character path that DOS allows. But when Timbuktu 



Pro adds the drop directory name, sender directory name, and date/time directory name --
c:\files\jane\10-31-12.32i
-- the path name becomes longer than DOS permits. The files in the lower reaches of the 
sales directory cannot be sent.
You can avoid this by transferring individual directories from inside the sales directory. For 
example, instead of including c:\sales, include c:\sales\southern\quarter1 and c:\sales\
southern\quarter2, etc. This shortens the final directory depth in the recipient's drop 
directory.
Alternatively, if you have access, you can use Exchange instead of Send, and copy the c:\
sales directory to the root level of the recipient's disk drive. This avoids adding the extra 
path of the drop directory.

The Send function reports that the remote computer is out of disk space

There are two possibilities:
The remote computer is out of disk space.
The Protect 

 Megabytes of disk space from use by drop directory value in the Preferences dialog box 
could be set too low.
In either case, the remote user will have to be the one to solve the problem by clearing 
some space on his or her hard drive, or by resetting the amount of space that Timbuktu Pro 
is to protect.

Memory information

Are you low on memory?

If Timbuktu Pro does not run or you cannot run other Windows applications when Timbuktu 
Pro is running, you may be experiencing a low DOS memory problem. Because Windows sits 
on top of DOS, Windows applications and the Windows operating system need a certain 
amount of low memory, that is, memory below 1MB. This problem usually appears on 
portable computers that use PCMCIA socket service drivers; however, desktop systems can 
also exhibit the problem.

Try one or more of the following suggestions to free up memory.

Review the list of DOS drivers and TSRs you are using and stop loading the less 
important ones. 

Maximize low DOS memory by using a Memory Manager such as EMM386 or QEMM to
load DOS drivers and DOS TSRs into upper memory. Refer to your memory manager 
documentation for specific instructions.

If you are running Windows for Workgroups with a third-party video driver and you do
not need advanced video functionality, try using the standard Windows Super VGA driver. 
Run the Windows setup program to switch video drivers.

If you are running TCP/IP only under Windows for Workgroups, consider using the 
Microsoft VxD-based TCP/IP stack with NDIS 3.x drivers. This will greatly reduce your low 
memory usage.

Limit the number of Windows applications you have open at one time.
Lower the Timbuktu Pro memory requirement by switching off support for protocols 

you do not need. This requires a change in the TB2.INI file, as explained in "Switching off 
network support" below.
You may also experience difficulties if your computer or the computer you are controlling is 
low on Windows memory. You can free Windows memory by closing unneeded applications.    
The following problems may indicate low Windows memory:



Your mouse pointer isn't moving as smoothly as usual.
Your screen partially redraws and then stops for 100 seconds.
A Control window closes if you maximize it.

Switching off network support
If you need to switch off a network protocol, pick the protocol you want to disable and follow 
the instructions below.

To switch off NetWare support:

1. Open the TB2.INI file with a text editor.
2. Edit the ProtocolSupport line so that it reads

ProtocolSupport=2
3. Save and close the TB2.INI file.
4. Shut down and restart Timbuktu Pro to enable your change.
To switch off TCP/IP support:

1. Open the TB2.INI file with a text editor.
2. Edit the ProtocolSupport line so that it reads

ProtocolSupport=3
3. Save and close the TB2.INI file.
4. Shut down and restart Timbuktu Pro to enable your change.
Cannot see Excel spreadsheet in a Word document

Under low memory conditions, an embedded Excel spreadsheet, via OLE, may not be 
displayed in a Word document. The spreadsheet is still there and editable, but cannot be 
viewed.

Miscellaneous information

Do not double-click service buttons

Do not double-click the Control, Observe, or Exchange buttons; a single click is all that is 
required.

Do not use Windows for Workgroups' NWLINK

Timbuktu Pro for Networks does not work with the NWLINK IPX stack included in Windows for
Workgroups; however, it does function properly with Novell's IPXODI. Windows will attempt 
to use NWLINK even if you have IPXODI loaded.
If either "IPX/SPX Compatible Transport," or "IPX/SPX Compatible Transport with NetBIOS" 
appears as a protocol when you run the Network Setup program, remove it. This disables 
Microsoft's NWLINK IPX stack and allows Novell's IPXODI to work properly with Timbuktu Pro.

Cancelling the Windows for Workgroups log on prompt

You may not be able to connect to a Windows for Workgroups computer because Timbuktu 
Pro is prevented from running until someone physically logs on to Windows. You can use the 
following procedure to switch off this dialog box.
1. Open the Control Panel.
2. Double-click the Network option.
3. In the Microsoft Windows Network dialog box, click the Startup button, in the lower left 

corner.
4. In the Startup Settings dialog box, deselect Log On at Startup, in the Startup Options 



panel.
5. Click OK in each dialog box until you return to the Control Panel window.
6. If desired, close the Control Panel.



 Definitions
Click an entry to read its definition

activity log Observe
address book Observe window
attended access observer
computer name password
connect personal address book
connection buttons Personal connection tab
connection tabs PPP
Control previous user
Control window privileges
controller registered user
Copy from (Read) remote node
Copy to (Write) Remove
dial-up link Send
disconnect shared address book
drop directory Shared connection tab
enclosure site
Exchange Status bar
guest directory TCP/IP
guest user TCP/IP connection tab
IP temporary guest
IP address Timbuktu Pro Admin
IP name Timbuktu Pro for Networks
IPX Timbuktu Pro site
master password User Connections counter
NetWare user log
NetWare connection tab

 About Timbuktu Pro
About Timbuktu Pro displays the version number and the product code for your copy of 
Timbuktu Pro.

It also contains the button that allows you to display the "Brought to you by ..." list.
Brought to you by ...



 Brought to you by ...
Brought to you by ... shows a list of all the Timbuktu Pro for Networks team members' 
names. It is accessed through a button in the About Timbuktu Pro dialog box.



About Timbuktu Pro
About Timbuktu Pro displays the version number and the product code for your copy of 
Timbuktu Pro.



activity log
The activity log contains information on the connections that have been made to your PC. 
Each connection is logged with the date, time, and access privilege followed by a type of 
action, such as Begin, End, Admit, or Deny, then network transport, remote user name, 
computer name, and network address.



address book
Address books contain computer names and network addresses of other Timbuktu Pro users.
The personal and shared address books are displayed in the Personal and Shared connection
tabs in the Timbuktu Pro window. 



attended access
A Timbuktu Pro connection initiated when both you and the remote user are physically 
present at your computers. You must choose Admit Temporary Guest from the Connections 
menu to grant access to the remote Timbuktu Pro user, referred to as the temporary guest.



computer name
The name used to display your computer in the connection tabs of other Timbuktu Pro users.



connect
To establish an electronic link between your PC and one or more other computers on a 
shared network



connection buttons
Buttons in the Timbuktu Pro window that initiate a remote control or file transfer activity with
another computer: Send, Exchange, Control, and Observe.



connection tabs
Tabs in the Timbuktu Pro window in which you can select or enter the name or address of 
another computer: Personal, Shared, TCP/IP, and NetWare. Connection tabs are not displayed
if Timbuktu Pro does not detect the information required for their use on your computer.



Contents
Contents displays the contents of Timbuktu Pro's online help.



Control
A Timbuktu Pro user can control your PC from another computer.



Control-menu box
The icon at the left of the title bar.

This icon opens the Control menu for a window.



Control window
A view of another computer's desktop as seen by a controller.



controller
A Timbuktu Pro user who is remotely operating another computer.



 Copy
The Copy command duplicates the highlighted text and places the duplicate on the 
Clipboard.



Copy
The Copy command duplicates the highlighted text and places the duplicate on the 
Clipboard.



Copy From (Read)
Copy From (Read) allows another user to copy files from any directory on your computer 
using the Exchange service. If this is the only Exchange privilege granted, the remote user 
can neither delete any files from your disk nor copy any files to your PC.



Copy To (Write)
Copy To (Write) allows another Timbuktu Pro user to send files to any directory on your 
computer using the Exchange service. If this is the only Exchange privilege granted, the 
remote user cannot copy or delete files from your PC.



 Cut
The Cut command removes the highlighted text and places it onto the Clipboard.



Cut
The Cut command removes the highlighted text and places it onto the Clipboard.



dial-up link
A connection between your computer and a distant network using a modem and dial-up 
software at each end of the link.



disconnect
To end a Timbuktu Pro session. Either you or the other user can disconnect.



drop directory
The directory on the your disk in which files are saved when a remote user transfers files via 
the Send function. You can designate the name and location of your drop directory in the 
Preferences dialog box. The drop directory's default path is C:\FILES.



enclosure
When using the Send service, an enclosure can be a group of one or more files and 
directories that you can attach to a Timbuktu Pro FlashNote. When you receive a message 
from another user, the files and directories are initially placed in your drop directory. You are
then given the option of moving enclosures to the location of your choice.



Exchange
A Timbuktu Pro user can copy files in both directions between his or her computer and your 
PC. With Exchange:

You can see the names of the files and directories on both computers.
You can copy files to and from any location on either computer if you have been 

granted the Copy From (Read) and Copy To (Write) privileges.
You can create a directory on either computer to receive the transferred files.
You can remove files from either computer if you have been granted the Remove 

privilege.



Exit
Exit quits the Timbuktu Pro application.



guest user
A Timbuktu Pro user who is allowed to use any of the privileges assigned to the <Guest> 
line in the Define Users dialog box. A guest user can connect any time your User Access is 
switched on. A guest user is not prompted to enter a password.



guest directory
A directory titled with the remote user's name that is created in your drop directory.



How to use Help
How to use Help describes how to navigate through Timbuktu Pro Help. It also explains how 
the Help features such as Annotate and Bookmark work.



IP address
A numeric address, such as 163.176.4.43, that can be specified when connecting to a 
computer running IP.



IP name
A name, such as timbuktu.farallon.com, that can be specified when connecting to a 
computer running IP. IP names can be used in Timbuktu Pro if the domain's name server 
administrator has set up entries for names and corresponding addresses.



IPX
Internet Packet Exchange, a network transport supported by Timbuktu Pro in the NetWare 
connection tab.



master password
Created in the Preferences dialog box, the master password can restrict access to the Define
Users, Preferences, and Password Requirements dialog boxes.



NetWare
One of the network transports used by Timbuktu Pro; NetWare is Novell's implementation of 
the IPX (Internet Packet Exchange) protocol.



NetWare connection tab
A browse list of Timbuktu Pro addresses that can be reached over the NetWare transport.



Observe
A Timbuktu Pro user can observe the activity on your desktop from another computer, but 
cannot control any actions on your PC.



Observe window
A view of another computer's desktop as seen by an observer.



observer
A Timbuktu Pro user who can view, but cannot operate, another computer.



password
An optional word or arbitrary set of characters which registered users must type in before 
they can connect to your computer; specified in the Define Users dialog box.



 Paste
The Paste command copies the contents of the Clipboard to the location indicated by your 
cursor.



Paste
The Paste command copies the contents of the Clipboard to the location indicated by your 
cursor.



Personal connection tab
A tab that displays your personal address book.



PPP
The acronym for Point to Point Protocol. A protocol for framing IP or IPX packets and shipping
them over a serial line, such as a pair of modems or a serial cable. Using this protocol allows
you to dial in to a network (such as the Internet) from home.



personal address book
A list of Timbuktu Pro addresses that you have copied from the NetWare or TCP/IP connection
tabs. It is displayed in the Personal connection tab.



previous user
A user who was once connected to your PC but either has completed his or her tasks or has 
been disconnected by you.



privileges
Specific kinds of access a Timbuktu Pro user can grant to his or her registered users, guest 
users, and temporary guests. Timbuktu Pro privileges are Send, Copy To (Write), Copy From 
(Read), Remove, Control, and Observe.



registered user
A Timbuktu Pro user who must enter a predesignated user name and password to connect to
your computer. The first time a registered user accesses your PC, he or she must enter the 
user name and password exactly as they were entered in your Define Users dialog box. 
Thereafter, the registered user is prompted for a user name, but can change the password, 
subject to your password requirements. Registered users cannot, however, change the user 
name or privileges you have set for them in the Define Users dialog box unless you have 
granted them the Control privilege.



remote node
When you use the remote client software that ships with Timbuktu Pro, you can dial in to a 
PPP server on a distant network. When you are authenticated as a user (or node) on that 
remote network, you can use all of Timbuktu Pro's features with that network's other 
workstations. In other words, you become a remote node on the network.



Remove
Remove allows another user to delete files from any directory on your computer using the 
Exchange function. If this is the only Exchange privilege granted, the remote user cannot 
copy files to or from your PC.



Send
A Timbuktu Pro user can send notes and files to your drop directory.



shared address book
A list of Timbuktu Pro addresses that has been prepared by a network administrator for a 
group of Timbuktu Pro users. It is displayed in the Shared connection tab.



Shared connection tab
A connection tab that displays your shared address book.



site administrator
A Timbuktu Pro user who is a person designated by his or her organization to run the 
Timbuktu Admin application and set up Timbuktu Pro sites. If a site key is installed on your 
computer, an <Administrator> line appears above the <Guest> line in the Define Users 
dialog box. This line shows what privileges the site administrator has been granted on your 
PC. You cannot delete the <Administrator> line nor can you disable the dimmed privileges. 
You can, however, select additional privileges for the administrator.



Status bar
The area along the bottom of the Timbuktu Pro main window. It contains two information 
panels. The panel on the left displays a short help description for any menu command that 
you select. The panel on the right -- the User Connections counter -- tells you haw many 
remote users are currently connected to your PC.



TCP/IP
The acronym for Transmission Control Protocol/Internet Protocol. An open network standard 
that defines how devices from different manufacturers communicate with each other over 
one or more interconnected networks. TCP/IP protocols are the foundation of the Internet, a 
world-wide network of networks connecting businesses, governments, researchers, and 
educators. This transport is supported by Timbuktu Pro in the TCP/IP connection tab.



TCP/IP connection tab
A tab in which you can enter the IP name or IP address of a Timbuktu Pro user.



temporary guest
A Timbuktu Pro user who is granted attended access only when you choose Admit Temporary
Guests from the Connections menu. He or she is allowed to use any of the privileges you 
select on the <Temporary Guest> line of the Define Users dialog box. A temporary guest is 
not prompted for a password.



Timbuktu Pro Admin
A special version of Timbuktu Pro for Macintosh that lets a Timbuktu administrator create 
and update Timbuktu Pro sites, set Timbuktu policy, and connect to site members as an 
administrator.



Timbuktu Pro for Networks
Remote control and file transfer software that supports connections across networks. 
Timbuktu Pro for Networks supports connections across TCP/IP and IPX networks. Windows 
users can connect to Macintosh computers that are equipped with Timbuktu Pro for 
Macintosh.



Timbuktu Pro site
A group of computers, either Windows or Macintosh, connected by a network which share a 
common set of rules governing Timbuktu Pro connections between site members and 
nonmembers, as well as among the members.



Types of users
There are four types of Timbuktu Pro users: the guest user, the temporary guest, the 
registered user, and the site administrator.



User Connections counter
The area on the right side of the Status bar which indicates the number of Timbuktu Pro 
users currently attached to your PC.



user log
The user log is the list of names located under the Clear Previous User Log command in the 
Connections menu. It contains the names of users that have connected to your PC via 
Timbuktu Pro. The list of names is erased when the Clear Previous User Log command is 
selected.
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